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Then use these integers as the matrix indices to identify the cell to be opened. We have
the boardSet[5][4] matrix containing the original values that needs to the displayed in the
cell. Use the gototxy function to display the cell value in the respective: position.

Replacing Unmatched Cells

When the user enters the input continuously, we have to match the cell values between two
consecutive inputs. If the cell values are identical, then the cells have to remain visible. If
not, the values in the opened cells needs to be replaced with the default values, that is, with
the ‘@ symbol. This is enforced by the ReplaceWithDefault function. This function takes the
cell numbers as its input and replaces the cell value with the default symbol in the same
position if the cell values do not match.

Redrawing the Matrix

As the user enters the input continuously, the screen starts scrolling up and at a particular
moment, the game board vanishes. At this stage, it becomes difficult for the user to enter
the cell number without seeing the matrix. Hence, it is necessary to redraw the matrix after
receiving the input from the user for a specific number of times.

To enforce this, a variable named “counter “ is maintained. It is incremented whenever it
encounters an output statement (including error messages). If this variable reaches a
particular value the screen is cleared and the matrix is redrawn using the CurrentMatrix
function. This function uses boardCurrent[5][4] matrix to store the current status of the
game board.

Code for the Memory Game

/* MemoryGame.cpp.*/

#include "stdafx.h"

#include <iostream>

#include <string>

#include <conio.h>

#include <dos.h>

#include <stdlib.h>

#include <stdio.h>

#include <windows.h>

#include "RandomGeneration.h"

using namespace std;

void gotoxy(short x, short y)
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{

HANDLE hCon = GetStdHandle(STD_OUTPUT_HANDLE);
COORD pos;

pos.X=x-1;

pos.Y=y-1;

SetConsoleCursorPosition(hCon, pos);

}

class Game

{
char boardDefault[5][4]; // board with @.
char boardSet[5][4]; // board with values.
char boardCurrent[5][4]; // current values held in the board.
char cmpl,cmp2; // comparing the cell values.
int tries; // No of attempts;
int t1,t2; //holds the temp cell numbers
int t3,t4; //holds the temp cell numbers
int i;

public:
Game ()
{

i=0;
tries=0;

}

void CreateBoard()

{

int k=0;
cout<<"\n\n\n\n";
cout<<"\t\t";

// Printing the column headings.

for(int j=0;j<4;j++)
{

}

cout<<endl<<endl;
cout<<"\t\t\t";

cout<<"\t"<<j;

// Underlining the column headings.
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for( j=0;j<25;j++)
{

}
cout<<endl<<endl;
cout<<"\t";

COUt<<"*";

// Filling the board with the default characters

char row='A';

for(int i=0;i<5;i++)

{
cout<<"\t"<<row;
for(3=0;3<4;j++)
{

boardDefault[i][j] = '@';
boardCurrent[i][j] =boardDefault([i][j] ;
cout<<"\t"<< boardDefault[i][j];

}

cout<<endl<<endl;
cout<<"\t";
row++;

}

void FillBoard()
{

char a[10];

int randno[10];

int rno;

RandomGeneration *rg;
rg=new RandomGeneration();

rno=rg->DrawRandomNumber() ;
//cout<<rno;

for(int k=0;k<10;k++)

{
randno[k]=rno * k;
a[k]=randno[k];
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if(alk]=="\0')
alkl="%";
//cout<<a[k]<<endl;

// Filling the values for the board.
// This symbol in the value gets opened when the user
// enters the resepctive cell number.
k=0;
for(int i=0;i<5;i++)
{
for(int j=0;j<4;j++)
{

boardSet[i][j] = a[k];
//cout<<boardSet[i][j]<<"\t";

if(k==9)
k=0;
else
k++;

}
//cout<<endl;

}

void ChangeCell()
{
int bb,cnt=0;
int counter =0;
int cell_1=0,cell_2=0;

char cellno[2];

char choice;
//cout<<endl;

do



cc:

tries=0;
cout<<"Enter -1 to exit ";
CreateBoard();

i=0;

while(true)

{

if(counter >2)

i++:
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//gotoxy(1,22);

int flag=0;

for(int m=0;m<5;m++)

{

for(int n=0;n<d;n++)

{
}
if (flag==0)
{
}
else

if( boardCurrent[m}[n] == '@")
{

flag=1;

continue;

system("cls");
gotoxy(24,9);

gotoxy(26,10);

cout<<"You have completed in "<<trjes <<" Tries.";
gotoxy(28,13);

cout<<endl<<" PLAY AGAIN (Y/N) ";

goto bb;

{
system("cl1s");
CurrentMatrix();



506 — Object-Oriented Programming with C++

counter =0;
cnt=0;

goto dd;

}

dd: cout<<"Enter the cell number to be opened: ";
cin>>cellno;
counter++;
if(strlen(cellno)>2)
{
cout<<"\n Enter valid cell no.."; counter++; goto cc;

}
else
{

tries++;

if (i==3)

{

if(cmpl != cmp2)

{

ReplaceWithDefault(tl,t2);
boardCurrent[t1][t2] ='@€';
ReplaceWithDefault(t3,td);
boardCurrent[t3][t4] ='@';
t1=t2=t3=t4=0;

i=1;

Y/t
else
i=1;
Y /it
if(cellno[0] == '-' && cellno[1] == '1')
{
system("cls");
gotoxy(28,13);
cout<<endl<<" PLAY AGAIN (Y/N) ";
goto bb;
break;
}
else
{//cout<<cellno<<endl;

// CONVERTING 'A‘,'B','C','D','E' TO 0,1,2,3,4
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switch(cellno[0])
{
case 'A':
case 'a':
cell 1=0; break;
case 'B':
case 'b':
cell 1=1; break;
case 'C':
case 'c':
cell 1=2; break;
case 'D':
case 'd':
cell _1=3; break;
case 'E':
case 'e':
cell 1=4; break;
default :
{
gotoxy(1,22+cnt);
cout<<"\nEnter valid cell no..";
//gotoxy(1,22+cnt);
counter++;

goto cc;// break;
}

}

//cout<<cell l<<endl;

//CONVERTING '0','1','2','3"' T0 0,1,2,3

switch(cellno[1])
{
case '0': cell 2=0; break;
case 'l': cell 2=1; break;
case '2': cell 2=2; break;
case '3': cell 2=3; break;
default :
{
gotoxy(1,22+cnt);
cout<<"\nEnter valid cell no..";
counter++;
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goto cc;
}
}
if(boardCurrent[cell 1][cell 2] != '@')
{
gotoxy(1l,22+cnt);
cout<<" Cell is already open... \n";

goto dd;
}

//cout<<endl;
else
{
IdentifyLocation(cell 1,cell 2,cnt);
if (i==1)
{
cmpl = boardSet[cell_1][cell 2];
tl=cell I;
t2=cell _2;

cmp2 = boardSet[cell 1][cell 2];
t3=cell_1;
t4=cell 2;
}
cout<<boardSet[cell 1][cell 2];
// storing the current instance of the matrix

boardCurrent[cell 1][cell 2] =boardSet[cell 1][cell 2];
gotoxy(1,22+cnt); // to go to the next line
cnt++;

}//else for re-entry of opened cell

//else

}
}//else for strlen(cellno)
}//else

}//while

bb: cin>> choice;
system("cls");

} while(choice =='Y' || choice=='y');
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void CurrentMatrix()

{

int 1,3;

cout<<"\n\n\n\n";
cout<<"\t\t";

for(j=0;j<4;j++)
{

}
cout<<endl<<endl;
cout<<"\t\t\t";

cout<<"\t"<<j;

for( j=0;j<25;j++)
{

}
cout<<endl<<endl;
cout<<"\t";

char row='A"';
for(i=0;i<5;i++)

{

cout<<"*",

cout<<"\t"<<row;
for(j=0;j<4;j++)

{
if(boardCurrent[i][j] !='\0")
cout<<"\t"<<boardCurrent[i][j];
else
{
boardCurrent[i][j] = '@';
cout<<"\t"<<boardCurrent[i][j];
}
Y// for j
cout<<"\n";
row++;

cout<<"\n\t";

Y// for i

0509
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void Identifylocation(int cell I,int cell 2,int cnt)
{
if(cell 1 ==0) // 'A'
{
switch(cell 2)
{
case 0: gotoxy(25,9); break;
case 1: gotoxy(33,9);break;
case 2: gotoxy(41,9); break;
case 3: gotoxy(49,9);break;
default :
{
gotoxy(1,22+cnt); .
cout<<"\nEnter valid cell no"; break;

}
}//if k=0 ,'A’
if(cell 1 ==1) // 'B
{
switch(cell 2)
{
case 0: gotoxy(25,11); break;
case 1: gotoxy(33,11);break;
case 2: gotoxy(41,11); break;
case 3: gotoxy(49,11);break;

}
V////if k=1, 'B®
if(cell 1 ==2) // 'C
{
switch(cell 2)
{
case
case
case
case

gotoxy (25,13
gotoxy(33,13
gotoxy (41,13
: gotoxy(49,13

; break;
sbreak;
; break;
sbreak;

)
)
)
)

W N = O

}
/113 k=2 ,'C

if(cell 1 ==3) // 'D'
{

switch(cell_2)

{
case 0: gotoxy(25,15); break;
case 1: gotoxy(33,15);break;
case 2: gotoxy(41,15); break;
case 3: gotoxy(49,15);break;
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}
}//if k=3 ,'D!

if(cell 1 ==4) // 'E'
{
switch(cell 2)
{

case 0: gotoxy(25,17); break;
case 1: gotoxy(33,17);break;
case 2: gotoxy(41,17); break;
case 3: gotoxy(49,17);break;

!

// goto 11;

Y//if k=4 ,'E!

}

void ReplaceWithDefault(int vall,int val2)
{

switch(vall)
{
case 0:{// 'A'
switch(val2)
{
case 0: gotoxy(25,9); cout<<'@';break;
case 1: gotoxy(33,9); cout<<'@';break;
case 2: gotoxy(41,9); cout<<'@';break;
’ case 3: gotoxy(49,9); cout<<'@';break;
}
break;
}
case 1:{// 'B'
switch(val2)
{
case 0: gotoxy(25,11);cout<<'@';break;
case 1: gotoxy(33,11);cout<<'@';break;
case 2: gotoxy(41l,11);cout<<'@';break;
case 3: gotoxy(49,11);cout<<'@';break;
1
break;
}
case 2:{// 'C'
switch(val2)

{
case 0: gotoxy(25,13);cout<<'@';break;
case 1: gotoxy(33,13);cout<<'@';break;
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case 2: gotoxy(41,13);cout<<'@';break;
case 3: gotoxy(49,13);cout<<'@';break;

}

break;

}

case 3:{// 'D'

switch(val2)

{
case 0: gotoxy(25,15); cout<<'@'; break;
case 1: gotoxy(33,15); cout<<'@'; break;
case 2: gotoxy(41,15); cout<<'@';break;
case 3: gotoxy(49,15); cout<<'@';break;

}

break;

}

case 4: {// 'E'

switch(val2)

{
case 0: gotoxy(25,17);cout<<'@';break;
case 1: gotoxy(33,17);cout<<'@';break;
case 2: gotoxy{41,17);cout<<'@';break;
case 3: gotoxy(49,17);cout<<'@';break;

}

break;

}
}//outer switch

}// ReplaceWithDefault();
}s

void main()

{

Game g;
g.Fil1Board(); // board with values
g.ChangeCel1();

}

/*RandomGeneration.h*/
//Generating random number

#include "stdafx.h"
#include <time.h>
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#include <iostream>
#include<conio.h>

/*#ifdef DEBUG
#define new DEBUG_NEW
#undef THIS FILE

static char THIS FILE[] = FILE ;
#endif*/

using namespace std;

class RandomGeneration

{
t

int Low,High;

public:
RandomGeneration();
void SetTimerSeed();
int DrawRandomNumber();
int GetHigh();
int GetLow();

Vs

RandomGeneration :: RandomGeneration()
{

Low = 1;

High = 100;
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// Set the seed to generate pseudo-random numbers. Use the current time & date as seed.

void RandomGeneration::SetTimerSeed() ({
time t SeedTime;
struct tm SeedDate;
SeedTime = time(0);
SeedDate = *tocaltime(&SeedTime);

int FinalSeed = SeedTime + SeedDate.tm mday + (SeedDate.tm mon+l) +

(SeedDate.tm year+1900);
srand((unsigned int) FinalSeed);

}



514 e Object-Oriented Programming with C++

// Return the Random number

// Interval : Self explanatory - Get the difference between the high and Tow Values

// RandomOffset = using the rand() function to generate random numbers from 0 to
Interval-1

// RandomNumber = Add the RandomOffset to the lowest number.

int RandomGeneration::DrawRandomNumber() {
int Interval = GetHigh() - GetlLow() + 1;
int RandomOffset = rand() % Interval;
int RandomNumber = GetLow() + RandomOffset;

//cout<<RandomNumber;
return RandomNumber;

}

// Standard Inpectors - Return High & Low values

int RandomGeneration::GetHigh() {
return High;

}

int RandomGeneration::GetLow() {
return Low;

}

IA.Z The Employee Attendance System

Problem Statement

Create an application to track the employee leave information. The application should:

Receive the employee information from the user.

Validate the user entries such as name, address and phone number.

Receive the attendance information for each employee. '

Accept the leave information, calculate the number of days leave taken and update
the status of Casual Leave (CL), Medical Leave (ML) and Earned Leave (EL) ac-
cordingly.

Display monthly attendance for all employees.

Display the leave status for a particular employee or for all employees.

Automate the generation of employee number and stores the complete employee
information into a file.

# Calculate the leave based on the following table:

L B

»* 0"
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Contain the following Main menu with options accessible using numeric keys:

Main Menu Key

Enter Employee Data
Enter Leave Form

Enter Attndance

Close Monthly Attendance
Employe Leave Status

ST W

Learning Objectives

The designing of the Employee Attendance project enable the students to:

Create a simple C++ application using the concept of Object-oriented programming
Use pointers extensively

Explore the use of date and time functions

Perform validation to execute the program effectively

Create, store, update and retrieve data in files

LR X N B
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IB. 1 Introduction

All programs in this book were developed and run under Turbo C++ compiler Version 3.0, in
an MS-DOS environment on an IBM PC compatible computer. We shall discuss briefly, in
this Appendix, the creation and execution of C++ programs under Turbo C++ system.

IB.Z Creation and Execution of Programs

Executing a computer program written in any high-level language involves several steps,
as listed below:

1.
2.
3.

6.
7.
8.

Develop the program (source code).

Select a suitable file name under which you would like to store the program.
Create the program in the computer and save it under the filename you have de-
cided. This file is known as source code file.

Compile the source code. The file containing the translated code is cailed object
code file. If there are any errors, debug them and compile the program again.
Link the object code with other library code that are required for execution. The
resulting code is called the executable code. If there are errors in linking, correct
them compile the program again.

Run the executable code and obtain the results, if there are no errors.

Debug the program, if errors are found in the output.

Go to Step 4 and repeat the process again.

These steps are illustrated in Fig. B.1. The exact steps depend upon the program
environment and the compiler used. But, they will resemble the steps described above.
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Turbo C++ and Borland C++ are the two most popular C++ compilers. They provide ideal
platforms for learning and developing C++ programs. In general, both Turbo C++ and Borland
C++ work the same way, except some additional features supported by Borland C++ which
are outside the scope our discussions. Therefore, whatever we discuss here about Turbo
C++ applies to Borland C++ as well.
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IB.S Turbo C+ +

Turbo C++ provides a powerful environment called Integrated Development Environment
(IDE) for creating and executing a program. The IDE is completely menu-driven and allows
the user to create, edit, compile and run programs using what are known as dialogue
‘boxes. These operations are controlled by single keystrokes and easy-to-use menus.

We first use the editor to create the source code file, then compile, link and finally run it.

Turbo C++ provides error messages, in case errors are detected. We have to correct the
errors and compile the program again.

lB.4 IDE Screen

It is important to be familiar with the details of the IDE screen that will be extensively used
in the program development and execution. When we invoke the Turbo C++, the IDE screen

will be displayed as shown in Fig. B.2. As seen from the figure, this screen contains four
parts:

# Main menu (top line)
# Editor window
# Message window
# Status line (bottom line)
= File Edit Search Run Compile Debug Project Options Window Help
: Main
NONAME 00.CPP 1 menu
Editor
window
— 1:1
Message 2
Message
window
F1Help F2Save F3 Open Ait-F9 Compile F9 Make F10 Menu Istatus
ine

Fig. B.2 « IDE opening screen E
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Main Menu

The main menu lists a number of items that are required for the program development and
execution. They are summarized in Table B.1.

Table B.1 Muain menu items

Item Options

‘ Displays the version number, clears or restores the screen, and execute
various utility programmes supplied with Turbo C++ ;

File Loads and saves files, handless directories invokes DOS, and exists
Turbo C+

Edit Performs various editing functions

Search Performs various text searches and replacements

Run Complies, links and runs the program currently joaded in the environ-
ment 3

Compile Compiles the program currently in the environment

Debug Sets various debugger options, including setting break points

Projects Manages multifile projects

Options Sets various compiler, linker, and environmental options

Window Controls the way varicus windows are displayed

Help Activates the context-sensitive Help system

it B R YRR Y S L 8

The main menu can he activated by pressing the F10 key. When we select an iter on the
main menu, a pull-down nienu, containing various options, is displayed. This allows us
to select an action that relates to the main menu item.

Editor Window

The editor window is the place for creating the source code of C++ programs. This window
is named NONAMEO0.CPP. This is the temporary name given to a file which can be changed
while we save the file.

Message Window

The other window on the screen is called the message window where various messages are
displayed. The messages may be compiler and linker messages and error messages generated
by the compiler.

Status Line

The status line which is displayed at the bottom of the screen gives the status of the current
activity on the screen. For example, when we are working with FILE option of main menu.
the status line displays the following:

F1 Help | Locate and open a file
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IB.S Invoking Turbo C++

Assuming that you have installed the Turbo C++ compiler correctly, go to the directory in
which you want to work. Then enter TC at the DOS system prompt:

C:>TC

and press RETURN. This will place you into the IDE screen as shown in Fig. B.2. Now, you
are ready to create your program.

lB.6 Creating Source Code File

Once you are in the IDE screen, it is simple to create and save a program. The F10 key will
take you to main menu and then move the cursor to File. This will display the file dialogue
window containing various options for file operations as shown in Fig. B.3. The options
include, among others, opening an existing file, creating a new file and saving the new file.

= File Edit Search-Run Compile Debug Project Options Window Help

—

"New |- NONAME oo.cPP ——— 1 —

Open... F3
Save F2
Save as ...

Save all
Change dir ....
Print

DOS shell

Quit Alt+ X

—  1:1

Message 2

F1 Help | Locate and open afile

Fig. B.3 « File dialogue window

Since you want to create a new file, move the cursor to New option. This opens up a blank
window called editing window and places the cursor inside this window. Now the system is
ready to receive the program statements as shown in Fig. B.4.
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= File Edit Search Run Compile Debug Project Options Window Help

NONAME 00.CPP _ 1 —

# include <iostream. h>
main()

{

cout << “C++ is better than C";
return 0,

——

Message —————————— 2

F1 Help F2 Save F3 Open Alt-F9 Compile F9 Make F10 Menu

Fig. B4 <« Editor screen with statements |
i

-

Once the typing is completed, you are ready to save the program in a file. At this time,
you must go to the File dialogue menu again to select a suitable file option. Press F10 and
select File option on the main menu. Select the save as option. This brings the save editor
file window as shown in Fig. B.5.

= File Edit Search Run Compile Debug Project Options Window Help

NONAME 00.CPP —_— 1 ——
————— Save File As
Save File As
CATC\PROG\NONAMEO1. CPP OK
Files
A
1:1 Cancel
[ Help — 2 —
! C\TC\BIN\NONAMEO1.CPP
i , Directory June 2000, 9.30am

F1 Help | Locate and open a file

Fig. B.5 <« Save editor file window

it i
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Now, you may change the file name NONAMEOO.CPP (shown in the editor file window)
to the name you have selected. Make sure that your name has the extension .CPP to indicate
to the compiler that your program is a C++ one and not C. Let’s Assume that vou have
selected test.cpp as name. Press RETURN key and the program is saved in the file test.cpp.

IB.7 Compiling the Program

When you select the compile option on the main menu, the compile dialogue window is
displayed as shown in Fig. B.6. The compile to OBJ option allows you to compile the current
file in the editor to an object file. In the present case, test.obj file is created, if there are no
errors in your program. If there are any errors, appropriate error messages are displayed in
the message window.

= File Edit Search Run Compile Debug Project Options Window Help

- 1 —
Compile Alt + F9

Make F9
Link
Build all

Information .....
Remove messages

Message _ 2 -

F1 Help | Compile to executable (EXE file)

Fig. B.6 < Compile dialogue menu

1

During compilation, a window called compilation window will appear on the screen as
shown in Fig. B.7. If there are no errors during compilation, this window will display
“Success: Press any key” message. The entries for warning and errors will be 0.

IB.8 Linking

To link the object file test.obj with the library functions, select the LINK EXE file option
from the compile menu (See Fig. B.6). The test.obj will be linked and a third file named
test.exe is created.
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i

° File Edit Search Run Compile Debug Project Options Window Help

— TEST.CPP 1 —
#include <iostream.h>
! main()
3 {
cout << “C++ is better than C”;
return O;
}
Compiling
Main file : . \TEST.CPP
Compiling: EDIT OR -> TEST.CPP
Total File
Lines compiled: 882 882
Warnings : 0 0
S Errors : 0 0

Available memory : 1940K

Success : Press any key

F1 Help Alt-F8 Next Msg Alt-F7 Prev Msg Alt-F9 Compile F9 Make F10 Menu

Fig. B.7 < Compilation window !

|B.9 Running the Program

You have reached successfully the final stage of your excitement. Now, select the Run from
the main menu and again Run from the run dialogue window (See Fig. B.8). You will see
the screen flicker briefly. Surprisingly, no output is displayed. Where has the output gone?
It has gone to a place known as user screen.

In order to see the user screen, select window from the main menu and then select user
screen from the window dialogue menu (See Fig.B.9). The IDE screen will disappear and
the user screen is displayed containing output of the program test.cpp as follows:

c>TC

Note that, at this point, you are outside the IDE. To return to IDE, press RETURN key.
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= File Edit Search Run Compile Debug Project Options Window Help

‘[ Message
i

#include <iostream> Run Ctri+F9
main() Program reset Ctri+F2
{ Go to cursor F4
cout << C++is Trace into F7
return 0: Step over F8
} Arguments ...
— 1:1
2 7

F1 Help | Execute or single-step through a program

Fig. B.8 <« Run dialogue menu %

= File Edit Search Run Compile Debug Project Options Window Help

) Size/Move Ctri+F5
#include <iostream.h> Zoom F5

main() Tile

{ Cascade
cout << “C++ is better than C”; Next F6

return O; Close Ait+F3
} Close all

Message

Output

Watch

User Screen  Alt+F5
Register

Project

—1:1 Projec t Notes

—1 Listall Alt+0

Message

F1 Help | Make the next window active

Fig. B.9 & Window dialogue menu §
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IB.lO Managing Errors

It is rare that a program runs successfully the first time itself. It is common to make some
syntax errors while preparing the program or during typing. Fortunately, all such errors
are detected by the compiler or linker.

Compiler Errors

All syntax errors will be detected by the compiler. For example, if you have missed the
semicolon at the end of the return statement in test.cpp program, the following message
will be displayed in the message window.

Error...\TEST.CPP 6 Statement missing;
Warning...\TEST.CPP 7: Function should return a value

The number 6 is the possible line in the program where the error has occurred. The
screen now will look like the one in Fig. B.10.

= File Edit Search Run Compile Debug Project Options Window Help

TEST .CPP —_— 1
#include <iostream.h>
main()
{
cout << “C++ is better than C”;
return 0

Message —_— 2 —
Compiling ..\TEST.CPP:

Error .\TEST.CPP 6: Statement missing;

Warning .\TEST.CPP 7: Functions should return value

F1 Help Alt-F8 Next Msg Alt F7 Prev Msg Alt-F9 Compile F9 Make F10 Menu

Fig. B.10 <« Display of error message l

Press ENTER key to go to Edit window that contains your program. Correct the errors
and then compile and run the program again. Hopefully, you will obtain the desired results.
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Linker Errors

[t is also possible to have errors during the linking process. For instance, you may not have
included the file iostream.h. The program will compile correctly, but will fail to link. It will
display an error message in the linking window. Press any key to see the message in the
message window.,

Run-time Errors

Remember compiling and linking successfully do not always guaranty the correct results.
Sometimes, the results may be wrong due logical errors or due to errors such as stack
overflow. System might display the errors such as null pointer assignment. You must consult
the manual for the meaning of such errors and modify the program accordingly.

IB.I 1 Handling an Existing File

After saving vour file to disk, your file has become a part of the list of files stored in the disk.
How do we retrieve such files and execute the programs written to them? You can do this in
two ways:

1. Under DOS prompt
2. Under IDE

Under DOS prompt, you can invoke as follows:
¢ > TC TEST.CPP
Remember to type the complete and correct name of the file with .cpp extension. This
command first brings Turbo C++ IDE and then loads edit window containing the file
test.cpp.
If vou are working under IDE. then select open option from the file menu. This will

prompt you for a file name and then loads the file as vou respond with the correct file name.
Now you can edit the program, compile it and execute it as before.

IB.12 Some Shortcuts

1t is possible to combine the two steps of compiling and linking into one. This can be achieved
by selecting Make EXE file from the compile dialogue window.

We can shorten the process by combining the execution step as well with the above step.
In this case, we must select Run option from the run dialogue window. This causes the
program to be compiled, linked and executed.
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Many common operations can be activated directly without going through the main
menu, again and again. Turbo C++ supports what are known as fof kevs to provide these
shortcuts. A list of hot keys and their functions ave given Tubde B2 We can use them
whenever necessary.

Hot Key Meaning
F1 Activates the online Help system
F2 Saves the file currently being edited
F3 Loads a file
F4 Executives the program unit the cursor is reached
F5 Zooms the active window
Fé6 Switches between windows
F7 Traces program: skips function culls
F8 Traces program; ships function calls
F9 Compiles and links progranis
F10 Activates the main mienu
ALT-O Lists open windows
ALT-n Activates window n in must be 1 through 9)
ALT-F1 Shows the previous help screen
ALT-F3 Deletes the active window
ALT-F4 Opens an Inspector window
ALT-F5 Opens an [nspector window
ALT-F7 Previous ervor
ALT-F8 Next error
ALT-F9 Cowmpiles file to .OBJ
ALT-SPACEBAR Activates the main meou
ALT-C Activates the Compiie mena
ALT-D Activates the Debug menu
ALT-E Activates the Edit menu
ALT-F Activates the File menu
ALT-H Activates the Help menu
ALT-O Activates the Uplions menu
ALT-P Activates the Project menu
ALT-R Activates the Run menu
ALT-S Activates the Run tiwernio
ALT-W Activates the Window menu 2

(Contd)



5308 Object-Oriented Programming with C++

A C++ programmer can easily become a Visual C++ programmer if he knows how to use
the implementation tools of his Visual C++ system. In this Appendix, we introduce the
features of Microsoft Visual C++ and discuss how to create, compile aind execute C++ prograins
under Windows.

The Microsoft Corporation has introduced a Windows based C++ development environment
named as Microsoft Visual C++ (MSVC). This development environment integrates & set
of tools that enable a programmer to create and run C++ programs with ease and style.
Microsoft calls this integrated development environment (IDE) as Visual Workbench.
Microsoft Visual Studio, a product sold by Microsoft Corporation. also includes Visual
C++. in addition to other tools like Visual Basic, Visual J++, Visual Foxpro, cte.

IC.Z The Visual Workbench

It is important to be familiar with the Visual Workbench that will be extensively used o the
program development. The Visual Workbench is a visual user interface designed to help
implement C++ programs. This contains various tools that are required for creating, cditing,
compiling, linking and running of C++ programs under Windows. These tools mclude File,
Edit, Search, Project, Resource, Debug, Tools, Window and Help.

. chmmll\llsual C+s - [Textl]
D File Edt View Inssrl Project  Build Tuoh Wmduw Hela

i1 1 .
st A \\‘\~
! N ~ Tooi bar
Document
“\ window
TS View Pane L | Doveloper
o . window
RILIE B2 j
4 IS
4 =  Message
window
| ;
B0 sma/oawg)\ Findn Fies 1 Y. Find m Files 2 X ‘i } N
Ready Int,oaly ool e e Status line

Fig. C.2 < Visual workbench opening screen
iy i




Appendix C €531

When we invoke the Microsoft Visual C++ (Version 6.0), the initial screen of the Visual
Workbench will be displayed as shown in Fig. C.2. As seen from the figure, this screen
contains five parts: 1) Title bar 2) Main menu 3) Tool bar 4) Developer window 5) Status
line.

Main Mcnu

The main menu lists a number of items that are required for program development and
execution. They are summarized in Table C.1.

Table C.1 Main menu of visual workbench

Item Functions / Options

Iile Creates a new file or opens an existing file for editing. Closes and saves files. Exits
the Visual Workbench.

Edit © DPerforms various editing functions, such as searching, deleting, copying, cutting
and pasting.

View Enable different views of screen, output, workspace.

Tosert Insertion of Graphics resources like pictures, icons, HTML, etc. can be done.

Project Sets up and edits a project (a hist of files).

Buiid Compiles the source code in the active window. Builds an executable file. Detects
2rrors

Tools Customizes the environment, the editors and the debugger.

Window Controls the visibility of various Windows involved in an application development.

Help Provides help about using Visual C++ through Microsoft Developer Network
Library (MSDN Library). Online help also can be received provided an Internet
connection.

Once a main menu item is selected, a pull-down menu, containing various options, is
displayed. This allows us to select an action/command that relates to the main menu item.

It 1s likely that an option in the pull-down menu is grayed. This means that the particular
option 1s currently not available or not valid. For example, the Save option in the File menu
will be grayed if the workspace is empty.

Seme options are followed by three periods (...). Such an option, when selected, will display
a submenu known as dialog box suggesting that some more input is required for that option
to get implemented. Options followed by the symbol p means we have to select a choice
from the list.

FTool Bar

The tool bar resides just below the'main menu. This provides a shortcut access to many of
the main menu's options with a single mouse click. Figure. C.3 shows some important tool
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For entering a new program. select File/C++ Source File option and then click on the OK
button. This opens up a blank window tsimilar to Fig. C.2) with the window title as 'Microsoft
Visual C++ - [CPP[" and piaces the cursor inside this edit window. Now the system is ready
to receive the program statements as shown in Fig. C 6.

Saving the Progran:

Once the typing is completed. vou are ready to execute the program. Although a program
can be compiled and run before it ie saved | it is always advisable to save the program in a file
before compilation. You eoan do so by doing one of the following:

1. Using File/Save command
2. Pressing the Ctrl+5S hot kev comhination
3.

Clicking on the third butten from left on the toolbar.
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When a file is saved for the first time, the system will present you with a save dialog box
Save this under the file name TEST.CPP.

After the file is saved, the title in the title bar will show the ¢aved file's name.

IC.S Compiling and Linking

In Visual C++, the process of compiling and linking all the source files to create an executable
file is called “building”. There are three ways of compiling a type source code and is <hown
in Table C.2.
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5(1.7 Maraging Errors

[t is rare that a program runs successfully the first time itself. When the program contains
errors, they are displayed in the message window as shown in Fig. C.10.
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Fig. C.10 < Output window error messages

Yuu can duuble-click on 2 syntax error in the message window to go to the line containing
that problem. Fix all the errors, recompile and exccute the program.

i(],ii Other Features

Windows programmers now have a wider range of tools that can be used for the development
of obicet-oricnted syvstems, Microsoft has provided, among others, the following three tools
that woudd benefit the programmers:

#  Poundation Class Library
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do

double
dynamic_cast

else

enum

explicit
export
¢xtern
false
loat

for
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do is a control statement that creates a loop of operations. It is used with
another keyword while in the form:
do
{
statements
}
while(expression);
he loop is terminated when the expression becomes zero.
Itis a floating-point data types specifier. We use this specification to double
the number of digits after decimal point of a floating-point value.
It is a casting operator used to cast the type of an object at runtime. Its
main application is to perform casts on polymorphic objects.
clse is used to specify an alternative path in a two-way branch control of
execution. 1t is used with it statement in the form:
if(expression)
statement-1;
else
statement-2;
The statement-1 is executed if expression is nonzero; otherwise statement-
2 s executed.
It is used to create a user-defined integer data type. Example:
enum E{el,e2,...};
where el, e2, .... are enumerators which take integer values. E is a data
type and can be used to declare variables of its type.
It is a specifier to a constructor. A constructor declared as explicit cannot
perform implicit conversion.
It is used to instantiate non-inline template classes and functions from
separate files.
extern is a storage class specifier which informs the compiler that the
variable so declared is defined in another source file.
It is a Boolean type constant. It can be assigned to only a bool type variable.
The default numeric value of false is 0.
It is a fundamental data type and is used to declare a variable to store a
single-point precision value. .
for is a control statement and is used to create a loop of iterative operations.
It takes the form:
for(el; e2; e3) statement;
The statement is executed until the expression e2 becomes zero. The
expression el is evaluated once in the beginning and e3 is evaluated at
the end of every iteration.
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goto

if

inline

int

long

mutable

namespace

new
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friend declares a function as a friend of the class where it is declared. A
function can be declared as a friend to more than one class. A friend
function, although defined like a normal function, can have access to all
the members of a class to which it is declared as friend.
goto is a transfer statement that enables us to skip a group of statements
unconditionally. This statement is very rarely used.
if is a control statement that is used to test an expression and transfer the
control to a particular statement depending upon the value of expression.
if statement may take one of the following forms:
(i) if (expression)
statement-1;
statement-2;
(ii) if (expression)
statement-1;
else
statement-2;
In form (i), if the expression is nonzero (true), statement-1 is executed
and then statement-2 is executed. If the expression is zero (false),
statement-1 is skipped. In form (ii), if the expression is nonzero, statement-
1is executed and statement-2 will be skipped; if it is zero, statement-2 is
executed and statement-1 is skipped.
inline is a function specifier which specifies to the compiler that the
function definition should be substituted in all places where the function
is called.
It is one of the basic data types and is used to declare a variable that
would be assigned integer values.
long is a data type modifier that can be applied to some of the basic data
types to increase their size. When used alone as shown below, the variable
becomes signed
Tong int.
long m;
It is a data type modifier. A data item declared mutable may be modified
even if it is a member of a const object or const function.
It is used to define a scope that could hold global identificrs. Example:
namespace name

[

1
Declaration of identifiers

}

It is an operator used for allocating memory dynamically from free store.
We can use new in place of malloe() function.
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volatile
wchar_t

while
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is a generic pointer that can be assigned a pointer of any type. It is also
used to declare a function that returns nothing. Another use is to indicate
that a function does not take any arguments. Example:

void print(void);
It is a qualifier used in variable declarations. It indicates that the variable
may be modified by factors outside the control of the program.
It is a character data type and is used to declare variables to hold 16-bit
wide characters.
while is a control statement used to execute a set of statements repeatedly
depending on the outcome of a test. Example:

while (expression)

{

statements

}

The statements are executed until the expression becomes zero.
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Tecedence

The Table E.1 below lists all the operators supported by ANSI C++ according to their
precedence (i.e. order of evaluation). Operators listed first have higher precedence than
those listed next. Operators at the same level of precedence (between horizontal lines) evaluate

either left to right or right to left according to their associativity.

Table E.1 C++ Operators

Operator

Sizeof
sizeof
++
typeid
const_cast
dynamic_cast
reinterpret_cast
static_cast
)

Meaning

global scope
class, namespace scope

direct member
indirect member
subscript
function call

type construction
postfix increment
postfix decrement
size of object

size of type

prefix increment
prefix decrement
type identification
specialized cast
specialized cast
specialized cast
specialized cast
traditional cast
one’s complement

Associativity

right to left
left to right

left to right

right to left

' const_cast<expr>

Use

::name

name : . member
object.member

pointer->member

pointer|expr]|

expr{(arg)

typelexpr)

m++

m_.._

sizeof expr
sizeof (type)
++m

—-m

typeid(expr)

dynamic_cast<expr> ,
reinterpret_cast<expr> @
static_cast<expr>
(type)expr

~expr

(Contd)
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* @ +

new
new [ ]
delete

delete [ ]

logical NOT
unary minus
unary plus
address of
dereference
create object
create array

destroy object
destroy arrary

member dereference
indirect member dereference

Multiply
Divide
Modulus
add
subtract

left shift
right shift

less than

less than or equal to
greater than

greater than or equal to

equal
not equal

bitwise AND
bitwise XOR
bitwise OR
logical AND
logical OR

conditional expression
assignment
multiply update
divide update
modulus update
add update
substract update
left shift update
right shift update
bitwise AND update
bitwise OR update
bitwise XOR update

throw exception

comma

Object-Oriented Programming with C++

right to left
left to. right

left to right

left to right
left to right

left to right

left to right

left to right
left to right
left to right
left to right
left to right

left to right
right to left

right to left
left to right

! expr

— expr

+ expr

& value

* expr

new type
new type [ |

delete ptr
delete [ ] ptr

object.*ptr_to_member

ptr->*ptr_to_member

exprl * expr2
exprl / expr2

exprl % expr2
exprl + expr2
exprl — expr2

exprl << expr2
exprl >> expr2

exprl < expr2
exprl <= expr2
exprl > expr2
exprl >= expr2

exprl == expr2
exprl != expr2
exprl & expr2
exprl ® expr2

exprl | expr2
exprl && expr2
exprl | | expr2
exprl ? expr2: expr3
X = expr

X *= expr
X /= expr

x %= expr
X += expr
X — = expr
X <<= expr
X >>= expr
x &= expr
X |=expr
X A= expr
throw expr

exprl, expr2

s

L S

e

oo, SR A

|
|
;;,
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11.
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14.

15.

16.

Appendix F

Computers use the binary number system which uses binary digits called as bits.
The basic unit of storage in a computer is a byte represented by eight bits.

A computer language is a language used to give instructions to a computer.

A compiler translates instructions in programming language to instructions in
machine language.

Application software is a software that is designed to solve a particular problem or
to provide a particular service.

Systems software is a software that is designed to support the development and
execution of application programs.

An operating system is a system software that controls and manages the computing
resources such as the memory, the input and output devices, and the CPU.

An algorithm is a detailed, step-by-step procedure for solving a problem.

The goal of a software design is to produce software that is reliable, understandable,
cost effective, adaptable, and reusable.

Abstraction is the process of highlighting the essential, inherent aspects of an entity
while ignoring irrelevant details.

Encapsulation (or information hiding) is the process of separating the external
aspects of an object from the internal implementation details which should be hidden
from other objects.

Modularity is the process of dividing a problem into smaller pieces so that each
smaller module can be dealt with individually.

Organizing a set of abstractions from most general to least general is known as
inheritance hierarchy.

Object-oriented programming is a paradigm in which a system is modeled as a set
of objects that interact with each other.

In C++ an abstraction is formed by creating a class. A class encapsulates the
attributes and behaviors of an object.

The data members of a class represent the attributes of a class.
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17.
18.
19.
20.
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22.

23.

24.

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.
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The member functions of a class represent the behaviors of a class.

A base class is one from which other, more specialized classes are derived.

A derived class is one that inherits properties from a base class.

Polymorphism is the capability of something to assume different forms. In an object-

oriented language, polymorphism is provided by allowing a message or member

function to mean different things depending on the type of object that receives the

message.

Instantiation is the process of creating an object from a class.

We must use the statement #include <iostream> a preprocessor directive that

includes the necessary definitions for performing input and output operations.

The C++ operator <<, called the insertion operator, is used to insert text into an

output stream.

The C++ operator >>, called the extraction operator, is used to insert text into an

input stream.

All C++ programs begin executing from the main. Function main returns an integer

value that indicates whether the program executed successfully or not. A value of

0 indicates successful execution. while the value 1 indicates that a problem or error

occurred during the execution of the program.

A value is returned from a function using the return statement. The statement
return 0;

returns the value 0.

A C++ style comment begins with // and continues to the end of the line.

A C++ identifiers consists of a sequence of letters (upper and lowercase), digits, and

underscores. A valid name cannot begin with a digit character.

C++ 1dentifiers are case sensitive. For example, Name and name refer to two

different identifiers.

Avariable must be defined before it can be used. Smart programmers give a variable

an initial value when it is defined. _

The automatic conversion specifies that operands of type char or short are converted

to type int before proceeding with operation.

For an arithmetic operation involving two integral operands, the automatic

conversion specifies that when the operands have different types, the one that is

type int is converted to long and a long operation is performed to produce a long

result.

For an arithmetic operation involving two floating-point operands, the automatic

conversion specifies that when the operands are of different types, the operand

with lesser precision is converted to the type of the operand with greater precision.

A mixed-mode arithmetic expression involves integral and floating-point operands.

The integral operand is converted to the type of the floating-point operand, and the

appropriate floating-point operation is performed.

The precedence rules of C++ define the order in which operators are applied to

operands. For the arithmetic operators, the precedence from highest to lowest is

unary plus and minus; multiplication, division, and modules; and addition and

subtraction.

It is a good programming practice to initialize a variable or an object when it is

declared.



